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ASA CX Module

This chapter describes how to configure the ASA CX module that runs on the ASA.

Information About the ASA CX Module, page 27-1
Licensing Requirements for the ASA CX Module, page 27-6
Guidelines and Limitations, page 27-6

Default Settings, page 27-8

Configuring the ASA CX Module, page 27-8

Managing the ASA CX Module, page 27-23

Monitoring the ASA CX Module, page 27-27
Troubleshooting the ASA CX Module, page 27-32

Feature History for the ASA CX Module, page 27-33

Information About the ASA CX Module

The ASA CX module lets you enforce security based on the full context of a situation. This context
includes the identity of the user (who), the application or website that the user is trying to access (what),
the origin of the access attempt (where), the time of the attempted access (when), and the properties of
the device used for the access (how). With the ASA CX module, you can extract the full context of a
flow and enforce granular policies such as permitting access to Facebook but denying access to games
on Facebook, or permitting finance employees access to a sensitive enterprise database but denying the
same access to other employees.

How the ASA CX Module Works with the ASA, page 27-2
Monitor-Only Mode, page 27-3

Information About ASA CX Management, page 27-4
Information About Authentication Proxy, page 27-5
Information About VPN and the ASA CX Module, page 27-5
Compatibility with ASA Features, page 27-5
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How the ASA CX Module Works with the ASA

Note

The ASA CX module runs a separate application from the ASA. The ASA CX module includes external
management interface(s) so you can connect to the ASA CX module directly. Any data interfaces on the
ASA CX module are used for ASA traffic only.

Traffic goes through the firewall checks before being forwarded to the ASA CX module. When you
identify traffic for ASA CX inspection on the ASA, traffic flows through the ASA and the ASA CX
module as follows:

Traffic enters the ASA.

)

Incoming VPN traffic is decrypted.

Firewall policies are applied.

Traffic is sent to the ASA CX module.

The ASA CX module applies its security policy to the traffic, and takes appropriate actions.

o &1 A W DN

Valid traffic is sent back to the ASA; the ASA CX module might block some traffic according to its
security policy, and that traffic is not passed on.

7. Outgoing VPN traffic is encrypted.
8. Traffic exits the ASA.

Figure 27-1 shows the traffic flow when using the ASA CX module. In this example, the ASA CX
module automatically blocks traffic that is not allowed for a certain application. All other traffic is
forwarded through the ASA.

Figure 27-1 ASA CX Module Traffic Flow in the ASA
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Main System S
< Firewall
== inside Policy outside ==
Diverted Traffic

Block

ASA CX inspection
ASA CX

333470

If you have a connection between hosts on two ASA interfaces, and the ASA CX service policy is only
configured for one of the interfaces, then all traffic between these hosts is sent to the ASA CX module,
including traffic originating on the non-ASA CX interface (because the feature is bidirectional).
However, the ASA only performs the authentication proxy on the interface to which the service policy
is applied, because authentication proxy is applied only to ingress traffic (see Information About
Authentication Proxy, page 27-5).
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Monitor-Only Mode

For demonstration purposes, you can configure a service policy or a traffic-forwarding interface in
monitor-only mode.

For guidelines and limitations for monitor-only mode, see Guidelines and Limitations, page 27-6.
e Service Policy in Monitor-Only Mode, page 27-3
e Traffic-Forwarding Interface in Monitor-Only Mode, page 27-3

Service Policy in Monitor-Only Mode

For testing and demonstration purposes, you can configure the ASA to send a duplicate stream of
read-only traffic to the ASA CX module, so you can see how the module inspects the traffic without
affecting the ASA traffic flow. In this mode, the ASA CX module inspects the traffic as usual, makes
policy decisions, and generates events. However, because the packets are read-only copies, the module
actions do not affect the actual traffic. Instead, the module drops the copies after inspection. Figure 27-2
shows the ASA CX module in monitor-only mode.

Figure 27-2 ASA CX Monitor-Only Mode
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Traffic-Forwarding Interface in Monitor-Only Mode

You can alternatively configure ASA interfaces to be traffic-forwarding interfaces, where all traffic
received is forwarded directly to the ASA CX module without any ASA processing. For testing and
demonstration purposes, traffic-forwarding removes the extra complication of ASA processing.
Traffic-forwarding is only supported in monitor-only mode, so the ASA CX module drops the traffic
after inspecting it. Figure 27-3 shows the ASA GigabitEthernet 0/3 interface configured for
traffic-forwarding. That interface is connected to a switch SPAN port so the ASA CX module can inspect
all of the network traffic.
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Figure 27-3 ASA CX Traffic-Forwarding
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Information About ASA CX Management

e Initial Configuration, page 27-4
e Policy Configuration and Management, page 27-5

Initial Configuration

For initial configuration, you must use the CLI on the ASA CX module to run the setup command and
configure other optional settings.

To access the CLI, you can use the following methods:
e ASA 5585-X:
— ASA CX console port—The ASA CX console port is a separate external console port.

- ASA CX Management 1/0 interface using SSH—You can connect to the default IP address
(192.168.8.8), or you can use ASDM to change the management IP address and then connect
using SSH. The ASA CX management interface is a separate external Gigabit Ethernet
interface.

>
Note  You cannot access the ASA CX hardware module CLI over the ASA backplane using the
session command.

e ASA 5512-X through ASA 5555-X:

— ASA session over the backplane—If you have CLI access to the ASA, then you can session to
the module and access the module CLI.

— ASA CX Management 0/0 interface using SSH—You can connect to the default IP address
(192.168.1.2), or you can use ASDM to change the management IP address and then connect
using SSH. These models run the ASA CX module as a software module. The ASA CX
management interface shares the Management 0/0 interface with the ASA. Separate MAC
addresses and IP addresses are supported for the ASA and ASA CX module. You must perform
configuration of the ASA CX IP address within the ASA CX operating system (using the CLI
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or ASDM). However, physical characteristics (such as enabling the interface) are configured on
the ASA. You can remove the ASA interface configuration (specifically the interface name) to
dedicate this interface as an ASA CX-only interface. This interface is management-only.

Policy Configuration and Management

Note

After you perform initial configuration, configure the ASA CX policy using Cisco Prime Security
Manager (PRSM). Then configure the ASA policy for sending traffic to the ASA CX module using
ASDM or the ASA CLI.

When using PRSM in multiple device mode, you can configure the ASA policy for sending traffic to the
ASA CX module within PRSM, instead of using ASDM or the ASA CLI. Using PRSM lets you
consolodate management to a single management system. However, PRSM has some limitations when
configuring the ASA service policy; see the ASA CX user guide for more information.

Information About Authentication Proxy

Note

When the ASA CX needs to authenticate an HTTP user (to take advantage of identity policies), you must
configure the ASA to act as an authentication proxy: the ASA CX module redirects authentication
requests to the ASA interface IP address/proxy port. By default, the port is 885 (user configurable).
Configure this feature as part of the service policy to divert traffic from the ASA to the ASA CX module.
If you do not enable the authentication proxy, only passive authentication is available.

If you have a connection between hosts on two ASA interfaces, and the ASA CX service policy is only
configured for one of the interfaces, then all traffic between these hosts is sent to the ASA CX module,
including traffic orginiating on the non-ASA CX interface (the feature is bidirectional). However, the
ASA only performs the authentication proxy on the interface to which the service policy is applied,
because this feature is ingress-only.

Information About VPN and the ASA CX Module

The ASA includes VPN client and user authentication metadata from the Cisco AnyConnect client when
forwarding traffic to the ASA CX module, which allows the ASA CX module to include this information
as part of its policy lookup criteria. The VPN metadata is sent only at VPN tunnel establishment time
along with a type-length-value (TLV) containing the session ID. The ASA CX module caches the VPN
metadata for each session. Each tunneled connection sends the session ID so the ASA CX module can
look up that session’s metadata.

Compatibility with ASA Features

The ASA includes many advanced application inspection features, including HTTP inspection.
However, the ASA CX module provides more advanced HTTP inspection than the ASA provides, as well
as additional features for other applications, including monitoring and controlling application usage.

To take full advantage of the ASA CX module features, see the following guidelines for traffic that you
send to the ASA CX module:
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¢ Do not configure ASA inspection on HTTP traffic.

¢ Do not configure Cloud Web Security (ScanSafe) inspection. If you configure both the ASA CX
action and Cloud Web Security inspection for the same traffic, the ASA only performs the ASA CX
action.

e Other application inspections on the ASA are compatible with the ASA CX module, including the
default inspections.

¢ Do not enable the Mobile User Security (MUS) server; it is not compatible with the ASA CX
module.

¢ Do not enable ASA clustering; it is not compatible with the ASA CX module.

e If you enable failover, when the ASA fails over, any existing ASA CX flows are transferred to the
new ASA, but the traffic is allowed through the ASA without being acted upon by the ASA CX
module. Only new flows recieved by the new ASA are acted upon by the ASA CX module.

® (9.1(1) and earlier) Does not support NAT 64. In 9.1(2) and later, NAT 64 is supported.

Licensing Requirements for the ASA CX Module

Model

License Requirement

ASAv

Standard or Premium License.

All other models

Base License.

The ASA CX module and PRSM require additional licenses. See the ASA CX documentation for more
information.

Prerequisites

To use PRSM to configure the ASA, you need to install a certificate on the ASA for secure
communications. By default, the ASA generates a self-signed certificate. However, this certificate can
cause browser prompts asking you to verify the certificate because the publisher is unknown. To avoid
these browser prompts, you can instead install a certificate from a known certificate authority (CA). If
you request a certificate from a CA, be sure the certificate type is both a server authentication certificate
and a client authentication certificate. See the general operations configuration guide for more
information.

Guidelines and Limitations

Context Mode Guidelines
(9.1(2) and earlier) Supported in single context mode only. Does not support multiple context mode.
(9.1(3) and later) Supported in multiple context mode. See the following guidelines:

e The ASA CX module itself (configured in PRSM) is a single context mode device; the
context-specific traffic coming from the ASA is checked against the common ASA CX policy.

Cisco ASA Series Firewall ASDM Configuration Guide
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e For ASA CX module support, you cannot use the same IP addresses in multiple contexts; each
context must include unique networks.

Firewall Mode Guidelines

Supported in routed and transparent firewall mode. Traffic-forwarding interfaces are only supported in
transparent mode.

Failover Guidelines

Does not support failover directly; when the ASA fails over, any existing ASA CX flows are transferred
to the new ASA, but the traffic is allowed through the ASA without being inspected by the ASA CX.

ASA Clustering Guidelines

Does not support clustering.

IPv6 Guidelines
¢ Supports IPv6.

* (9.1(1) and earlier) Does not support NAT 64. In 9.1(2) and later, NAT 64 is supported.

Model Guidelines

e Supported only on the ASA 5585-X and 5512-X through ASA 5555-X. See the Cisco ASA
Compatibility Matrix for more information:

http://www.cisco.com/en/US/docs/security/asa/compatibility/asamatrx.html

e For the 5512-X through ASA 5555-X, you must install a Cisco solid state drive (SSD). For more
information, see the ASA 5500-X hardware guide.

Monitor-Only Mode Guidelines

* You cannot configure both monitor-only mode and normal inline mode at the same time on the ASA.
Only one type of security policy is allowed. In multiple context mode, you cannot configure
monitor-only mode for some contexts, and regular inline mode for others.

e The following features are not supported in monitor-only mode:
— Deny policies
— Active authentication
— Decryption policies

e The ASA CX does not perform packet buffering in monitor-only mode, and events will be generated
on a best-effort basis. For example, some events, such as ones with long URLs spanning packet
boundaries, may be impacted by the lack of buffering.

e Be sure to configure both the ASA policy and the ASA CX to have matching modes: both in
monitor-only mode, or both in normal inline mode.

Additional guidelines for traffic-forwarding interfaces:
¢ The ASA must be in transparent mode.

e You can configure up to 4 interfaces as traffic-forwarding interfaces. Other ASA interfaces can be
used as normal.

e Traffic-forwarding interfaces must be physical interfaces, not VLANs or BVIs. The physical
interface also cannot have any VLANs associated with it.
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e Traffic-forwarding interfaces cannot be used for ASA traffic; you cannot name them or configure
them for ASA features, including failover or management-only.

¢ You cannot configure both a traffic-forwarding interface and a service policy for ASA CX traffic.

Additional Guidelines and Limitations
e See Compatibility with ASA Features, page 27-5.

¢ You cannot change the software type installed on the hardware module; if you purchase an ASA CX
module, you cannot later install other software on it.

Default Settings

Table 27-1 lists the default settings for the ASA CX module.

Table 27-1 Default Network Parameters
Parameters Default
Management IP address ASA 5585-X: Management 1/0 192.168.8.8/24

ASA 5512-X through ASA 5555-X: Management 0/0
192.168.1.2/24

Gateway ASA 5585-X:192.168.8.1/24

ASA 5512-X through ASA 5555-X: 192.168.1.1/24
SSH or session Username admin
Password Adminl123

Configuring the ASA CX Module

This section describes how to configure the ASA CX module.
e Task Flow for the ASA CX Module, page 27-9
e Connecting the ASA CX Management Interface, page 27-10
e (ASA 5585-X) Changing the ASA CX Management [P Address, page 27-14
e (ASA 5512-X through ASA 5555-X; May Be Required) Installing the Software Module, page 27-13
e Configuring Basic ASA CX Settings at the ASA CX CLI, page 27-16
e Configuring the Security Policy on the ASA CX Module Using PRSM, page 27-18
e Redirecting Traffic to the ASA CX Module, page 27-19
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Task Flow for the ASA CX Module

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Step 7

Configuring the ASA CX module is a process that includes configuration of the ASA CX security policy
on the ASA CX module and then configuration of the ASA to send traffic to the ASA CX module. To
configure the ASA CX module, perform the following steps:

Cable the ASA CX management interfaces interface. See Connecting the ASA CX Management
Interface, page 27-10.

(ASA 5512-X through ASA 5555-X; May be required) Install the software module. See (ASA 5512-X
through ASA 5555-X; May Be Required) Installing the Software Module, page 27-13.

(ASA 5585-X) Configure the ASA CX module management IP address for initial SSH access. See (ASA
5585-X) Changing the ASA CX Management IP Address, page 27-14.

On the ASA CX module, configure basic settings. You must use the CLI to configure these settings. See
Configuring Basic ASA CX Settings at the ASA CX CLI, page 27-16.

On the ASA CX module, configure the security policy using PRSM. See Configuring the Security Policy
on the ASA CX Module Using PRSM, page 27-18.

(Optional) On the ASA, configure the authentication proxy port. See (Optional) Configuring the
Authentication Proxy Port, page 27-19.

On the ASA, identify traffic to divert to the ASA CX module. See Redirecting Traffic to the ASA CX
Module, page 27-19.

N

Note  When using PRSM in multiple device mode, you can configure the ASA policy for sending
traffic to the ASA CX module within PRSM, instead of using ASDM or the ASA CLI. However,
PRSM has some limitations when configuring the ASA service policy; see the ASA CX user
guide for more information.
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Connecting the ASA CX Management Interface

In addition to providing management access to the ASA CX module, the ASA CX management interface
needs access to an HTTP proxy server or a DNS server and the Internet for signature updates and more.
This section describes recommended network configurations. Your network may differ.

ASA 5585-X (Hardware Module)

The ASA CX module includes a separate management interface from the ASA. For initial setup, you can
connect with SSH to the ASA CX Management 1/0 interface using the default IP address
(192.168.8.8/24). If you cannot use the default IP address, you can either use the console port or use
ASDM to change the management IP address so you can use SSH.

ASA 5585-X ASA CX SSP ASA CX Management 1/0
Default IP: 192.168.8.8

[anans] 1| »
| A A A AR

ASA Management 0/0
Default IP: 192.168.1.1

334655

If you have an inside router

If you have an inside router, you can route between the management network, which can include both
the ASA Management 0/0 and ASA CX Management 1/0 interfaces, and the ASA inside network for
Internet access. Be sure to also add a route on the ASA to reach the Management network through the
inside router.

Proxy or DNS Server (for example)
A

ASA CX Default
Gateway

il ASA CX Management 1/0
==

334657

—r
Management PC
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If you do not have an inside router

If you have only one inside network, then you cannot also have a separate management network, which
would require an inside router to route between the networks. In this case, you can manage the ASA from
the inside interface instead of the Management 0/0 interface. Because the ASA CX module is a separate
device from the ASA, you can configure the ASA CX Management 1/0 address to be on the same
network as the inside interface.

ASA CX Default Gateway

A——
Q! Layer 2

—_— Switch
Management PC
p-— idd =W Outside
— . ‘
@ T :

. ASA CX Management 1/0

Proxy or DNS Server
(for example) ASA Management 0/0 not used

334659

ASA 5512-X through ASA 5555-X (Software Module)

These models run the ASA CX module as a software module, and the ASA CX management interface
shares the Management 0/0 interface with the ASA.

ASA 5545-X ASA CX Management 0/0
Default IP: 192.168.1.2
ASA Management 0/0
Default IP: 192.168.1.1

334664
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If you have an inside router

If you have an inside router, you can route between the Management 0/0 network, which includes both
the ASA and ASA CX management IP addresses, and the inside network for Internet access. Be sure to
also add a route on the ASA to reach the Management network through the inside router.

Proxy or DNS Server (for example)

—

ASA gateway for Management

ASA CX Default
Gateway

il Management 0/0
s

d
Management PC

334666

If you do not have an inside router

If you have only one inside network, then you cannot also have a separate management network. In this
case, you can manage the ASA from the inside interface instead of the Management 0/0 interface. If you
remove the ASA-configured name from the Management 0/0 interface, you can still configure the ASA
CX IP address for that interface. Because the ASA CX module is essentially a separate device from the
ASA, you can configure the ASA CX management address to be on the same network as the inside
interface.

_| ASA CX Default Gateway
E4 Layer 2

% .
Management PC Switch
E Inside
|

Outside @

A—)
Proxy or DNS Server l\/ziréapg‘;%T(egrgl%O 8
&3

(for example)

Note  You must remove the ASA-configured name for Management 0/0; if it is configured on the ASA, then
the ASA CX address must be on the same network as the ASA, and that excludes any networks already
configured on other ASA interfaces. If the name is not configured, then the ASA CX address can be on
any network, for example, the ASA inside network.

What to Do Next

e Configure the ASA CX management IP address. See (ASA 5585-X) Changing the ASA CX
Management IP Address, page 27-14.
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(ASA 5512-X through ASA 5555-X; May Be Required) Installing the Software
Module

If you purchase the ASA with the ASA CX module, the module software and required solid state drive(s)
(SSDs) come pre-installed and ready to go. If you want to add the ASA CX to an existing ASA, or need
to replace the SSD, you need to install the ASA CX boot software and partition the SSD according to
this procedure. To physically install the SSD, see the ASA hardware guide.

Note  For the ASA 5585-X hardware module, you must install or upgrade your image from within the ASA
CX module. See the ASA CX module documentation for more information.

Prerequisites

e The free space on flash (disk0) should be at least 3GB plus the size of the boot software.

e In multiple context mode, perform this procedure in the system execution space.

Detailed Steps

Step1  Download the ASA CX boot software from Cisco.com to your computer. If you have a Cisco.com login,
you can obtain the boot software from the following website:

http://www.cisco.com/cisco/software/release.html?mdfid=284325223&softwareid=284399946

The boot software lets you set basic ASA CX network configuration, partition the SSD, and download
the larger system software from a server of your choice to the SSD.

Step 2 Download the ASA CX system software from Cisco.com to an HTTP, HTTPS, or FTP server accessible
from the ASA CX management interface. If you have a Cisco.com login, you can obtain the boot
software from the following website:

http://www.cisco.com/cisco/software/release.html?mdfid=284325223 &softwareid=284399946

Step 3 In ASDM, choose Tools > File Management, and then choose File Transfer > Between Local PC and
Flash. Transfer the boot software to diskO on the ASA. Do not transfer the system software; it is
downloaded later to the SSD.

Step4  Connect to the ASA CLI, and enter privileged EXEC mode. See “Getting Started” chapter in the general
operations configuration guide to access the ASA CLI.

Step5  If you are replacing the IPS module with the ASA CX module, shut down and uninstall the IPS module,
and then reload the ASA:

hostname# sw-module module ips shutdown
hostname# sw-module module ips uninstall
hostname# reload

After the ASA reloads, reconnect to the ASA CLI.
Step6  Set the ASA CX module boot image location in ASA diskO by entering the following command:

hostname# sw-module module cxsc recover configure image diskO:file path

Example:

hostname# sw-module module cxsc recover configure image diskO:asacx-boot-9.1.1l.img

Step7  Load the ASA CX boot image by entering the following command:

Cisco ASA Series Firewall ASDM Configuration Guide
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Step 8

Step 9

Step 10

Step 11

Step 12

hostname# sw-module module cxsc recover boot

Wait approximately 5 minutes for the ASA CX module to boot up, and then open a console session to
the now-running ASA CX boot image. The default username is admin and the default password is
Adminl23.

hostname# session cxsc console

Establishing console session with slot 1

Opening console session with module cxsc.

Connected to module cxsc. Escape character sequence is 'CTRL-SHIFT-6 then x'.
cxsc login: admin

Password: Adminl23

Partition the SSD:

asacx-boot> partition
Partition Successfully Completed

Perform the basic network setup using the setup command according to the Configuring Basic ASA CX
Settings at the ASA CX CLI, page 27-16 (do not exit the ASA CX CLI), and then return to this procedure
to install the software image.

Install the system software from the server:

asacx-boot> system install url

Example:

The following command installs the asacx-sys-9.1.1.pkg system software.

asacx-boot> system install https://upgrades.example.com/packages/asacx-sys-9.1.1.pkg

Username: buffy
Password: angelforever
Verifying
Downloading
Extracting
Package Detail
Description:
Requires reboot:
Cisco ASA CX System Upgrade
Yes
Do you want to continue with upgrade? [n]: Y
Warning: Please do not interrupt the process or turn off the system. Doing so might leave
system in unusable state.
Upgrading
Stopping all the services
Starting upgrade process
Reboot is required to complete the upgrade. Press Enter to reboot the system.

Press Enter to reboot the ASA CX module. Rebooting the module closes the console session. Allow 10
or more minutes for application component installation and for the ASA CX services to start.

(ASA 5585-X) Changing the ASA CX Management IP Address

If you cannot use the default management IP address (192.168.8.8), then you can set the management IP
address from the ASA. After you set the management IP address, you can access the ASA CX module
using SSH to perform initial setup.

Cisco ASA Series Firewall ASDM Configuration Guide
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Note  For a software module, you can access the ASA CX CLI to perform setup by sessioning from the ASA
CLI; you can then set the ASA CX management IP address as part of setup. See Configuring Basic ASA
CX Settings at the ASA CX CLI, page 27-16.

Guidelines

In multiple context mode, perform this procedure in the system execution space.
Detailed Steps

Multiple Context Mode

Step 1 In the System, choose Tools > Command Line Interface.

Step2  Enter the following command:

Command Purpose

session 1 do setup host ip Sets the ASA CX management IP address, mask, and gateway.
ip_address/mask,gateway._ip

Example:
hostname# session 1 do setup host ip
10.1.1.2/24,10.1.1.1

Step3  Click Send.

Single Context Mode

Step1  In ASDM, choose Wizards > Startup Wizard.

Step2  Click Next to advance through the initial screens until you reach the ASA CX Basic Configuration
screen.

Cisco ASA Series Firewall ASDM Configuration Guide
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800 Cisco ASDM 6.4 for ASA - 10.89.147.152 - Startup Wizard
Startup Wizard ASA CX Basic Configuration (Step 9 of 12)

In order to establish proper connectivity with the ASA CX service blade, please enter all necessary
information.

Note: ASA CX-related configuration is intended for bootstrapping. Modifying an existing ASA CX
configuration may lead 1o undesired results.

|| Select to Bypass ASA CX Configuration.
Metwork Settings

IP Address: | 10.89.147.153
Subnet Mask: |255.255.255.0 =
Gateway: 10.89.147.1

Auth Proxy Port

Auth Proxy Port (must be greater than 1024) 5000

< Back | Mext > | Finish | | Cancel | Help E
= = E ]

Step3  Enter the new management IP address, subnet mask, and default gateway.

Stepd  (Optional) Change the Auth Proxy Port. You can set this later if desired. See (Optional) Configuring the
Authentication Proxy Port, page 27-19 for more information.

Step5  Click Finish to skip the remaining screens, or click Next to advance through the remaining screens and
complete the wizard.

Configuring Basic ASA CX Settings at the ASA CX CLI

You must configure basic network settings and other parameters on the ASA CX module before you can
configure your security policy.

Detailed Steps

Step1 Do one of the following:
e (All models) Use SSH to connect to the ASA CX management [P address.

* (ASA 5512-X through ASA 5555-X) Open a console session to the module from the ASA CLI (see
the “Getting Started” chapter in the general operations configuration guide to access the ASA CLI).
In multiple context mode, session from the system execution space.

hostname# session cxsc console

Cisco ASA Series Firewall ASDM Configuration Guide
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Step 2

Step 3

Step 4

Step 5

Configuring the ASA CX Module W

Log in with the username admin and the password Admin123. You will change the password as part of
this procedure.

Enter the following command:

asacx> setup

Example:

asacx> setup

Welcome to Cisco Prime Security Manager Setup
[hit Ctrl-C to abort]

Default values are inside [ ]

You are prompted through the setup wizard. The following example shows a typical path through the
wizard; if you enter Y instead of N at a prompt, you will be able to configure some additional settings.
This example shows how to configure both IPv4 and IPv6 static addresses. You can configure IPv6
stateless auto configuration by answering N when asked if you want to configure a static [Pv6 address.

Enter a hostname [asacx]: asa-cx-host

Do you want to configure IPv4 address on management interface?(y/n) [Y]: Y

Do you want to enable DHCP for IPv4 address assignment on management interface?(y/n)[N]: N
Enter an IPv4 address [192.168.8.8]: 10.89.31.65

Enter the netmask [255.255.255.0]: 255.255.255.0

Enter the gateway [192.168.8.1]: 10.89.31.1

Do you want to configure static IPv6 address on management interface?(y/n) [N]: Y
Enter an IPv6 address: 2001:DB8:0:CD30::1234/64

Enter the gateway: 2001:DB8:0:CD30::1

Enter the primary DNS server IP address [ ]: 10.89.47.11

Do you want to configure Secondary DNS Server? (y/n) [N]: N

Do you want to configure Local Domain Name? (y/n) [N] Y

Enter the local domain name: example.com

Do you want to configure Search domains? (y/n) [N] Y

Enter the comma separated list for search domains: example.com

Do you want to enable the NTP service?(y/n) [N]: Y

Enter the NTP servers separated by commas: l.ntp.example.com, 2.ntp.example.com

After you complete the final prompt, you are presented with a summary of the settings. Look over the
summary to verify that the values are correct, and enter Y to apply your changed configuration. Enter N
to cancel your changes.

Example:

Apply the changes?(y,n) [Y]: ¥

Configuration saved successfully!

Applying...

Done.

Generating self-signed certificate, the web server will be restarted after that

Done.
Press ENTER to continue...
asacx>

~

Note  If you change the host name, the prompt does not show the new name until you log out and log
back in.

If you do not use NTP, configure the time settings. The default time zone is the UTC time zone. Use the
show time command to see the current settings. You can use the following commands to change time
settings:

asacx> config timezone
asacx> config time
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Step6  Change the admin password by entering the following command:

asacx> config passwd

Example:

asacx> config passwd

The password must be at least 8 characters long and must contain
at least one uppercase letter (A-Z), at least one lowercase letter
(a-z) and at least one digit (0-9).

Enter password: Farscapel

Confirm password: Farscapel

SUCCESS: Password changed for user admin

Step7  Enter the exit command to log out.

Configuring the Security Policy on the ASA CX Module Using PRSM

This section describes how to launch PRSM to configure the ASA CX module application. For details
on using PRSM to configure your ASA CX security policy, see the ASA CX user guide.

Detailed Steps

You can launch PRSM from your web browser, or you can launch it from ASDM.

e Launch PRSM from a web browser by enter the following URL:

https://ASA_CX_management_IP

Where the ASA CX management IP address is the one you set in the Configuring Basic ASA CX
Settings at the ASA CX CLI, page 27-16.

e Launch PRSM from ASDM by choosing Home > ASA CX Status, and clicking the Connect to the
ASA CX application link.

2 . : Harme
B
| i
£ oevice nformation List updated: 10:56:39AM O inertace Status Last updated: 10:56:30 AM

Model: ASA5585-5SP-CX10 Application Name: ASA CX Security Module
Hardware Version 1.3 Application Status: uUp
Serial Number; JAF1543CGRE Application Status Description: Normal Operation
Firmware Version: 2.0(13)0 Application Version: 0.6.1
Software Version: 0.6.1 Data plane Status: up
MAC Address Range: 70ca.9bf0.1ca0 to 70ca.9bf0.1cab Status: Up
Connect to the ASA CX application: ™ h : 89,147 44 E
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What to Do Next

e (Optional) Configure the authentication proxy port. See (Optional) Configuring the Authentication
Proxy Port, page 27-19.

e Redirect traffic to the ASA CX module. See Redirecting Traffic to the ASA CX Module, page 27-19.

(Optional) Configuring the Authentication Proxy Port

The default authentication port is 885. To change the authentication proxy port, perform the following
steps. For more information about the authentication proxy, see Information About Authentication
Proxy, page 27-5.

Note  (Single mode) You can also set the port as part of the ASDM startup wizard. See (ASA 5585-X)
Changing the ASA CX Management IP Address, page 27-14.

Guidelines

In multiple context mode, perform this procedure within each security context.

Detailed Steps

Step 1 In ASDM, choose Configuration > Firewall > Advanced > ASA CX Auth Proxy.

™ Configuration > Firewall > Advanced > ASA CX Auth Proxy

Configure ASA CX auth proxy port.

Auth proxy port value (must be greater than 1024): | 5000

Step2  Enter a port greater than 1024. The default is 885.
Step3  Click Apply.

Redirecting Traffic to the ASA CX Module

You can redirect traffic to the ASA CX module by creating a service policy that identifies specific traffic.
For demonstration purposes only, you can also enable monitor-only mode for the service policy, which
forwards a copy of traffic to the ASA CX module, while the original traffic remains unaffected.

Another option for demonstration purposes is to configure a traffic-forwarding interface instead of a
service policy in monitor-only mode. The traffic-forwarding interface sends all traffic directly to the
ASA CX module, bypassing the ASA.

e Creating the ASA CX Service Policy, page 27-20
e Configuring Traffic-Forwarding Interfaces (Monitor-Only Mode), page 27-22

Cisco ASA Series Firewall ASDM Configuration Guide
| g 2715



Chapter27  ASA CX Module |

Bl Configuring the ASA CX Module

Creating the ASA CX Service Policy

This section identifies traffic to redirect from the ASA to the ASA CX module. Configure this policy on
the ASA. If you want to use a traffic-forwarding interface for demonstration purposes, skip this
procedure and see Configuring Traffic-Forwarding Interfaces (Monitor-Only Mode), page 27-22
instead.

Note  When using PRSM in multiple device mode, you can configure the ASA policy for sending traffic to the
ASA CX module within PRSM, instead of using ASDM or the ASA CLI. However, PRSM has some
limitations when configuring the ASA service policy; see the ASA CX user guide for more information.

Prerequisites

e If you enable the authentication proxy on the ASA using this procedure, be sure to also configure a
directory realm for authentication on the ASA CX module. See the ASA CX user guide for more
information.

e If you have an active service policy redirecting traffic to an IPS module (that you replaced with the
ASA CX), you must remove that policy before you configure the ASA CX service policy.

¢ Be sure to configure both the ASA policy and the ASA CX to have matching modes: both in
monitor-only mode, or both in normal inline mode.

¢ In multiple context mode, perform this procedure within each security context.

Detailed Steps

Step 1 Choose Configuration > Firewall > Service Policy Rules.

& Firewall

B Access Rules .
E3 NAT Rules i
T |
B AMA Rules |
22" Filter Rules I
% Public Servers | |
T URL Filtering Servers

& Threat Detection

@ Identity Options -

Eﬁ: Device Setup
|§3 Firewall

g’g Remote Access VPN

gﬁ Site-to-Site VPN

E\!}ngs

E:jd Device Management

Step2  Choose Add > Add Service Policy Rule. The Add Service Policy Rule Wizard - Service Policy dialog
box appears.

Step3  Complete the Service Policy dialog box as desired. See the ASDM online help for more information
about these screens.

Stepd  Click Next. The Add Service Policy Rule Wizard - Traffic Classification Criteria dialog box appears.
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Step5 Complete the Traffic Classification Criteria dialog box as desired. See the ASDM online help for more
information about these screens.

Step6  Click Next to show the Add Service Policy Rule Wizard - Rule Actions dialog box.
Step7  Click the ASA CX Inspection tab.

ano Edit Service Policy Rule

Traffic Classification GRS (0T

Protocol Inspection Connection Settings Quos | 3

@ Enable ASA CX for this traffic flow
If ASA CX Card Fails

':_5.1 Permit traffic

Close traffic

Authentication Proxy

To enable auth proxy, select the checkbox
and click Apply. Then connect to the ASA
CX and enable auth proxy on the device.

Enable Auth Proxy

Owverride the default auth proxy port here:
Confiquration > Firewall > Advanced > ASA CX Auth Prosxy
Promiscuous Mode

Enable Monitar Only

Help Cancel | OK |

A02507

Step8  Check the Enable ASA CX for this traffic flow check box.
Step9  In the If ASA CX Card Fails area, click one of the following:

e Permit traffic—Sets the ASA to allow all traffic through, uninspected, if the ASA CX module is
unavailable.

* (Close traffic—Sets the ASA to block all traffic if the ASA CX module is unavailable.

Step10 (Optional) To enable the authentication proxy, which is required for active authentication, check the
Enable Auth Proxy check box. This option is not available in monitor-only mode.

Step11  (Optional) For demonstration purposes only, check the Monitor-only check box to send a read-only
copy of traffic to the ASA CX module. See Monitor-Only Mode, page 27-3 for more information.

N

Note  You must configure all classes and policies to be either in monitor-only mode, or in normal inline
mode; you cannot mix both modes on the same ASA.

Step12 Click OK and then Apply.
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Step 13

Repeat this procedure to configure additional traffic flows as desired.

Configuring Traffic-Forwarding Interfaces (Monitor-Only Mode)

This section configures traffic-forwarding interfaces, where all traffic is forwarded directly to the ASA
CX module. This method is for demonstration purposes only. For a normal ASA CX service policy, see
Creating the ASA CX Service Policy, page 27-20.

For more information see Monitor-Only Mode, page 27-3. See also the Guidelines and Limitations,
page 27-6 for guidelines and limitations specific to traffic-forwarding interfaces.

You can only configure this feature at the CLI; you can use the Command Line Interface tool.

Prerequisites

e Be sure to configure both the ASA policy and the ASA CX to have matching modes: both in

monitor-only.

e In multiple context mode, perform this procedure within each security context.

Detailed Steps

Step 1

Step 2

Step 3

Step 4

Step 1 Choose Tools > Command Line Interface.
Step2  Click the Multiple Line radio button.
Step3  Enter the following commands:

Command Purpose

interface physical interface

Example:
hostname (config)# interface
gigabitethernet 0/5

Enters interface configuration mode for the physical interface you
want to use for traffic-forwarding.

no nameif

Example:
hostname (config-ifc)# no nameif

Removes any name configured for the interface. If this interface
was used in any ASA configuration, that configuration is
removed. You cannot configure traffic-forwarding on a named
interface.

traffic-forward cxsc monitor-only

Example:
hostname (config-ifc)# traffic-forward cxsc
monitor-only

Enables traffic-forwarding. You see a warning similar to the
following:

WARNING: This configuration is purely for demo of CX
functionality and shouldn't be used on a production ASA
and any issues found when mixing demo feature with
production ASA is not supported.

no shutdown

Example:
hostname (config-ifc)# no shutdown

Enables the interface.

Step4  Repeat for any additional interfaces.
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Step5  Click Send.

Examples

The following example makes GigabitEthernet 0/5 a traffic-forwarding interface:

ano Command Line Interface

Type a command to be sent directly to the device. For command help, type a
command followed by a question mark. For commands that would prompt for
confirmation, add an appropriate noconfirm option as parameter to the command and
send it to the device. To make the changes permanent, use the File > Save Running
Configuration to Flash menu option to save the configuration to flash.

Command

' Single Line -- Multiple Line g Enable context sensitive. ..

interface gigabitethernet 0/5

no nameif

traffic-forward cxsc monitor-only
no shutdown|

Response:

Clear Response

Help Close | Send |

303700

Managing the ASA CX Module

This section includes procedures that help you manage the module.
e Resetting the Password, page 27-23
e Reloading or Resetting the Module, page 27-24
e Shutting Down the Module, page 27-25
e (ASA 5512-X through ASA 5555-X) Uninstalling a Software Module Image, page 27-26
e (ASA 5512-X through ASA 5555-X) Sessioning to the Module From the ASA, page 27-26

Resetting the Password

You can reset the module password to the default. For the user admin, the default password is
Adminl23. After resetting the password, you should change it to a unique value using the module
application.

Resetting the module password causes the module to reboot. Services are not available while the module
is rebooting.

Cisco ASA Series Firewall ASDM Configuration Guide
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If you cannot connect to ASDM with the new password, restart ASDM and try to log in again. If you
defined a new password and still have an existing password in ASDM that is different from the new
password, clear the password cache by choosing File > Clear ASDM Password Cache, then restart
ASDM and try to log in again.

To reset the module password to the default of Admin123, perform the following steps.

Guidelines

In multiple context mode, perform this procedure in the system execution space.

Detailed Steps

Step 1 From the ASDM menu bar, choose Tools > ASA CX Password Reset.

The Password Reset confirmation dialog box appears.
8no ASA CX Password Reset

Are you sure you want to reset ASA CX password? It will be set
& to factory default value "Adminl23'.

Cancel | Ok |

i<k c k]

Step2  Click OK to reset the password to the default Admin123.
A dialog box displays the success or failure of the password reset.

Step3  Click Close to close the dialog box.

Reloading or Resetting the Module

To reload or reset the module, enter one of the following commands at the ASA CLI.

Guidelines

In multiple context mode, perform this procedure in the system execution space.
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Command

Purpose

For a hardware module (ASA 5585-X):

hw-module module 1 reload

For a software module (ASA 5512-X through
ASA 5555-X):

sw-module module cxsc reload

Example:
hostname# hw-module module 1 reload

Reloads the module software.

For a hardware module:

hw-module module 1 reset

For a software module:

sw-module module cxsc reset

Example:
hostname# hw-module module 1 reset

Performs a reset, and then reloads the module.

Shutting Down the Module

Shutting down the module software prepares the module to be safely powered off without losing
configuration data. Note: If you reload the ASA, the module is not automatically shut down, so we
recommend shutting down the module before reloading the ASA. To gracefully shut down the module,
perform the following steps at the ASA CLIL

Guidelines

In multiple context mode, perform this procedure in the system execution space.

Detailed Steps

Command

Purpose

For a hardware module (ASA 5585-X):

hw-module module 1 shutdown

For a software module (ASA 5512-X through
ASA 5555-X):

sw-module module cxsc shutdown

Example:
hostname# hw-module module 1 shutdown

Shuts down the module.
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(ASA 5512-X through ASA 5555-X) Uninstalling a Software Module Image

To uninstall a software module image and associated configuration, perform the following steps.

Guidelines

In multiple context mode, perform this procedure in the system execution space.

Detailed Steps

Command Purpose
Step1  sw-module module cxsc uninstall Permanently uninstalls the software module image and associated
configuration.
Example:

hostname# sw-module module cxsc uninstall
Module cxsc will be uninstalled. This will
completely remove the

disk image associated with the sw-module
including any configuration

that existed within it.

Uninstall module <id>? [confirm]

Step2 reload Reloads the ASA. You must reload the ASA before you can install
a new module type.

Example:
hostname# reload

(ASA 5512-X through ASA 5555-X) Sessioning to the Module From the ASA

To access the ASA CX software module CLI from the ASA, you can session from the ASA. You can
either session to the module (using Telnet) or create a virtual console session. A console session might
be useful if the control plane is down and you cannot establish a Telnet session.

You may need to access the CLI if you are using multiple context mode and you need to set basic network
settings using the CLI, or for troubleshooting.

Guidelines

In multiple context mode, perform this procedure in the system execution space.
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Command

Purpose

Telnet session.

session cxsc

Example:
hostname# session cxsc

Opening command session with slot 1.
Connected to module cxsc. Escape character
sequence is 'CTRL-"X'.

cxsc login: admin
Password: Adminl23

Accesses the module using Telnet. You are prompted for the username and
password. The default username is admin, and the default password is
Admin123.

Console session.

session cxsc console

Example:
hostname# session cxsc console

Establishing console session with slot 1
Opening console session with module cxsc.
Connected to module cxsc. Escape character
sequence is 'CTRL-SHIFT-6 then x'.

cxsc login: admin
Password: Adminl23

Accesses the module console. You are prompted for the username and
password. The default username is admin, and the default password is
Admin123.

Note Do not use this command in conjunction with a terminal server
where Ctrl-Shift-6, x is the escape sequence to return to the
terminal server prompt. Ctrl-Shift-6, x is also the sequence to
escape the ASA CX console and return to the ASA prompt.
Therefore, if you try to exit the ASA CX console in this situation,
you instead exit all the way to the terminal server prompt. If you
reconnect the terminal server to the ASA, the ASA CX console
session is still active; you can never exit to the ASA prompt. You
must use a direct serial connection to return the console to the ASA
prompt.

Use the session cxsc command instead.

Monitoring the ASA CX Module

Use Tools > Command Line Interface to use monitoring commands.

e Showing Module Status, page 27-28

e Showing Module Statistics, page 27-28

e Monitoring Module Connections, page 27-28

e Capturing Module Traffic, page 27-32

e Problems with the Authentication Proxy, page 27-32

S

Note  For ASA CX-related syslog messages, see the syslog messages guide. ASA CX syslog messages start
with message number 429001.
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Showing Module Status

See the ASA CX Status Tab in the general operations configuration guide.

Showing Module Statistics

To show module statistics, enter the following command:

Command Purpose
show service-policy cxsc Displays the ASA CX statistics and status per service policy.
Examples

The following is sample output from the show service-policy command showing the ASA CX policy
and the current statistics as well as the module status when the authentication proxy is disabled:

hostname# show service-policy cxsc
Global policy:
Service-policy: global_policy
Class-map: bypass
CXSC: card status Up, mode fail-open, auth-proxy disabled
packet input 2626422041, packet output 2626877967, drop 0, reset-drop 0, proxied 0

The following is sample output from the show service-policy command showing the ASA CX policy
and the current statistics as well as the module status when the authentication proxy is enabled; in this
case, the proxied counters also increment:

hostname# show service-policy cxsc
Global policy:
Service-policy: pmap
Class-map: class-default
Default Queueing Set connection policy: random-sequence-number disable
drop 0
CXSC: card status Up, mode fail-open, auth-proxy enabled
packet input 7724, packet output 7701, drop 0, reset-drop 0, proxied 10

Monitoring Module Connections

To show connections through the ASA CX module, enter one of the following commands:

Command Purpose

show asp table classify domain cxsc Shows the NP rules created to send traffic to the ASA CX module.

show asp table classify domain Shows the NP rules created for the authentication proxy for the ASA CX
cxsc-auth-proxy module.
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Command

Purpose

show asp drop

Shows dropped packets. The following drop types are used:
Frame Drops:

e cxsc-bad-tlv-received—This occurs when ASA receives a packet
from CXSC without a Policy ID TLV. This TLV must be present in
non-control packets if it does not have the Standy Active bit set in the
actions field.

e cxsc-request—The frame was requested to be dropped by CXSC due
a policy on CXSC whereby CXSC would set the actions to Deny
Source, Deny Destination, or Deny Pkt.

e cxsc-fail-close—The packet is dropped because the card is not up and
the policy configured was 'fail-close' (rather than 'fail-open' which
allows packets through even if the card was down).

e cxsc-fail—The CXSC configuration was removed for an existing
flow and we are not able to process it through CXSC it will be
dropped. This should be very unlikely.

¢ cxsc-malformed-packet—The packet from CXSC contains an invalid
header. For instance, the header length may not be correct.

Flow Drops:

e cxsc-request—The CXSC requested to terminate the flow. The
actions bit 0 is set.

e reset-by-cxsc—The CXSC requested to terminate and reset the flow.
The actions bit 1 is set.

e cxsc-fail-close—The flow was terminated because the card is down
and the configured policy was 'fail-close’.

show asp event dp-cp cxsc-msg This output shows how many ASA CX module messages are on the dp-cp

queue. Currently, only VPN queries from the ASA CX module are sent to
dp-cp.

show conn

This command already shows if a connection is being forwarded to a
module by displaying the ‘X - inspected by service module’ flag.
Connections being forwarded to the ASA CX module will also display the
‘X’ flag.

Examples

The following is sample output from the show asp table classify domain cxsc command:

hostname# show asp table classify domain cxsc
Input Table
in id=0x7ffedbd4acf40, priority=50, domain=cxsc, deny=false
hits=15485658, user_data=0x7ffedbd4ac840, cs_id=0x0, use_real_addr, flags=0x0,
protocol=0
src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=0.0.0.0, mask=0.0.0.0, port=0, dscp=0x0
input_ifc=outside, output_ifc=any
in id=0x7ffedb4ad4al, priority=50, domain=cxsc, deny=false
hits=992053, user_data=0x7ffedb4ac840, cs_id=0x0, use_real_addr, flags=0x0, protocol=0
src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=0.0.0.0, mask=0.0.0.0, port=0, dscp=0x0
input_ifc=inside, output_ifc=any
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in id=0x7ffedb4adal00, priority=50, domain=cxsc, deny=false
hits=0, user_data=0x7ffedb4ac840, cs_id=0x0, use_real_addr, flags=0x0, protocol=0

src ip/id=0.0.0.0, mask=0.0.0.0, port=0

dst ip/id=0.0.0.0, mask=0.0.0.0, port=0, dscp=0x0

input_ifc=m, output_ifc=any
Output Table:
L2 - Output Table:
L2 - Input Table:

Last clearing of hits counters: Never

The following is sample output from the show asp table classify domain cxsc-auth-proxy command.
For the first rule in the output, the destination “port=2000" is the auth-proxy port configured by the cxsc
auth-proxy port 2000 command, and the destination “ip/id=192.168.0.100” is the ASA interface IP

address.

hostname# show asp table classify domain cxsc-auth-proxy

Input Table

in 1d=0x7ffed86cc470, priority=121, domain=cxsc-auth-proxy,
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0,

src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=192.168.0.100, mask=255.255.255.255,
input_ifc=inside, output_ifc=identity

in 1id=0x7ffed86cce20, priority=121, domain=cxsc-auth-proxy,
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0,

src ip/id=0.0.0.0, mask=0.0.0.0, port=0

dst ip/id=2.2.2.2, mask=255.255.255.255, port=2000,

input_ifc=new2, output_ifc=identity

in 1id=0x7ffed86cd7d0, priority=121, domain=cxsc-auth-proxy,
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0,

src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=172.23.58.52, mask=255.255.255.255,
input_ifc=mgmt, output_ifc=identity

in 1id=0x7ffed86caa80, priority=121, domain=cxsc-auth-proxy,
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0,

src ip/id=0.0.0.0, mask=0.0.0.0, port=0
dst ip/id=192.168.5.172, mask=255.255.255.255,
input_ifc=outside, output_ifc=identity

in 1id=0x7ffed86cb3c0, priority=121, domain=cxsc-auth-proxy,
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0,

src ip/id=::/0, port=0

dst ip/id=fe80::5675:d0ff:fe5b:1102/128, port=2000

input_ifc=outside, output_ifc=identity

in 1id=0x7ffed742bel0, priority=121, domain=cxsc-auth-proxy,
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0,

src ip/id=::/0, port=0
dst ip/id=1:1:1:1::10/128, port=2000
input_ifc=outside, output_ifc=identity
Output Table:
L2 - Output Table:

L2 - Input Table:

Last clearing of hits counters: Never

deny=false
protocol=6

dscp=0x0

deny=false
protocol=6

deny=false
protocol=6

dscp=0x0

deny=false
protocol=6

dscp=0x0

deny=false
protocol=6

deny=false
protocol=6

The following is sample output from the show asp drop command. This output is just an example and
lists all the possible reasons for a dropped frame or flow from the ASA CX module:
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hostname# show asp drop
Frame drop:

CXSC Module received packet with bad TLV's (cxsc-bad-tlv-received)

CXSC Module requested drop (cxsc-request)

CXSC card is down (cxsc-fail-close)

CXSC config removed for flow (cxsc-fail)

CXSC Module received malformed packet (cxsc-malformed-packet)

Last clearing: 18:12:58 UTC May 11 2012 by enable_15
Flow drop:

Flow terminated by CXSC (cxsc-request)

Flow reset by CXSC (reset-by-cxsc)

CXSC fail-close (cxsc-fail-close)

Last clearing: 18:12:58 UTC May 11 2012 by enable_15

Monitoring the ASA CX Module

[ = V)

=

The following is sample output from the show asp event dp-cp cxsc-msg command:

hostname# show asp event dp-cp cxsc-msg

DP-CP EVENT QUEUE QUEUE-LEN HIGH-WATER
Punt Event Queue 0 5
Identity-Traffic Event Queue 0 0
General Event Queue 0 4
Syslog Event Queue 4 90
Non-Blocking Event Queue 0 2
Midpath High Event Queue 0 53
Midpath Norm Event Queue 8074 8288
SRTP Event Queue 0 0
HA Event Queue 0 0
Threat-Detection Event Queue 0 3
ARP Event Queue 0 2048
IDFW Event Queue 0 0
CXSC Event Queue 0 1
EVENT-TYPE ALLOC ALLOC-FAIL ENQUEUED ENQ-FAIL RETIRED 15SEC-RATE
cxsc-msg 1 0 1 0 1 0

The following is sample output from the show conn detail command:

hostname# show conn detail
0 in use, 105 most used

Flags: A - awaiting inside ACK to SYN, a - awaiting outside ACK to SYN,
B - initial SYN from outside, b - TCP state-bypass or nailed, C - CTIQBE media,

- Skinny media, M - SMTP data, m - SIP media, n - GUP

SQL*Net data, R - outside acknowledged FIN,

- VPN orphan, W - WAAS,
- inspected by service module

X <™ O F QO
1

- DNS, d - dump, E - outside back connection, F - outside FIN,
- group, g - MGCP, H - H.323, h - H.225.0, I - inbound data,
- incomplete, J - GTP, j - GTP data, K - GTP t3-response

- UDP SUNRPC, r - inside acknowledged FIN, S - awaiting inside SYN,
- awaiting outside SYN, T - SIP, t - SIP transient, U - up,

TCP outside 208.80.152.2:80 inside 192.168.1.20:59928, idle 0:00:10, bytes 79174,

XUIO

f - inside FIN,

- outbound data, P - inside back connection, p - Phone-proxy TFTP connection,

flags
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Capturing Module Traffic

To configure and view packet captures for the ASA CX module, enter one of the following commands:

Command Purpose

capture name interface asa dataplane Captures packets between ASA CX module and the ASA on the
backplane.

copy capture Copies the capture file to a server.

show capture Shows the capture at the ASA console.

S

Note  Captured packets contain an additional AFBP header that your PCAP viewer might not understand; be
sure to use the appropriate plugin to view these packets.

Troubleshooting the ASA CX Module

e Problems with the Authentication Proxy, page 27-32

Problems with the Authentication Proxy

If you are having a problem using the authentication proxy feature, follow these steps to troubleshoot
your configuration and connections:

1. Check your configurations.

e On the ASA, check the output of the show asp table classify domain cxsc-auth-proxy command
and make sure there are rules installed and that they are correct.

¢ In PRSM, ensure the directory realm is created with the correct credentials and test the connection
to make sure you can reach the authentication server; also ensure that a policy object or objects are
configured for authentication.

2. Check the output of the show service-policy cxsc command to see if any packets were proxied.

3. Perform a packet capture on the backplane, and check to see if traffic is being redirected on the
correct configured port. See Capturing Module Traffic, page 27-32. You can check the configured
port using the show running-config cxsc command or the show asp table classify domain
cxsc-auth-proxy command.

Note  If you have a connection between hosts on two ASA interfaces, and the ASA CX service policy is only
configured for one of the interfaces, then all traffic between these hosts is sent to the ASA CX module,
including traffic orginiating on the non-ASA CX interface (the feature is bidirectional). However, the
ASA only performs the authentication proxy on the interface to which the service policy is applied,
because this feature is ingress-only.

Example 27-1 Make sure port 2000 is used consistently:

1. Check the authentication proxy port:

Cisco ASA Series Firewall ASDM Configuration Guide
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hostname# show running-config cxsc
cxsc auth-proxy port 2000

2.

Check the authentication proxy rules:

hostname# show asp table classify domain cxsc-auth-proxy

Input Table

in

1d=0x7ffed86ccd70, priority=121, domain=cxsc-auth-proxy, deny=false
hits=0, user_data=0x7ffed86ca220, cs_id=0x0, flags=0x0, protocol=6
src ip/id=0.0.0.0, mask=0.0.0.0, port=0

dst ip/id=192.168.0.100, mask=255.255.255.255, port=2000, dscp=0x0
input_ifc=inside, output_ifc=identity

In the packet captures, the redirect request should be going to destination port 2000.

Feature History for the ASA CX Module

Table 27-2 lists each feature change and the platform release in which it was implemented. ASDM is
backwards-compatible with multiple platform releases, so the specific ASDM release in which support
was added is not listed.

Table 27-2 Feature History for the ASA CX Module

Feature Name

Platform
Releases Feature Information

ASA 5585-X with SSP-10 and -20 support for |[ASA 8.4(4.1) |The ASA CX module lets you enforce security based on the
the ASA CX SSP-10 and -20 ASA CX 9.0(1) |complete context of a situation. This context includes the

identity of the user (who), the application or website that the
user is trying to access (what), the origin of the access
attempt (where), the time of the attempted access (when),
and the properties of the device used for the access (how).
With the ASA CX module, you can extract the full context
of a flow and enforce granular policies such as permitting
access to Facebook but denying access to games on
Facebook or permitting finance employees access to a
sensitive enterprise database but denying the same access to
other employees.

We introduced the following screens:

Home > ASA CX Status

Wizards > Startup Wizard > ASA CX Basic Configuration
Configuration > Firewall > Service Policy Rules > Add
Service Policy Rule > Rule Actions > ASA CX Inspection

ASA 5512-X through ASA 5555-X support for |[ASA 9.1(1) We introduced support for the ASA CX SSP software

the ASA CX SSP

ASA CX 9.1(1) |module for the ASA 5512-X, ASA 5515-X, ASA 5525-X,
ASA 5545-X, and ASA 5555-X.

We did not modify any screens.
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Table 27-2 Feature History for the ASA CX Module (continued)
Platform
Feature Name Releases Feature Information
Monitor-only mode for demonstration ASA 9.1(2) For demonstration purposes only, you can enable

purposes

ASA CX 9.1(2)

monitor-only mode for the service policy, which forwards a
copy of traffic to the ASA CX module, while the original
traffic remains unaffected.

Another option for demonstration purposes is to configure a
traffic-forwarding interface instead of a service policy in
monitor-only mode. The traffic-forwarding interface sends
all traffic directly to the ASA CX module, bypassing the
ASA.

We modified the following screen: Configuration > Firewall
> Service Policy Rules > Add Service Policy Rule > Rule
Actions > ASA CX Inspection.

The traffic-forwarding feature is supported by CLI only.

NAT 64 support for the ASA CX module

ASA 9.1(2)
ASA CX 9.1(2)

You can now use NAT 64 in conjunction with the ASA CX
module.

We did not modify any screens.

ASA 5585-X with SSP-40 and -60 support for
the ASA CX SSP-40 and -60

ASA 9.1(3)
ASA CX 9.2(1)

ASA CX SSP-40 and -60 modules can be used with the
matching level ASA 5585-X with SSP-40 and -60.

We did not modify any screens.

Multiple context mode support for the ASA
CX module

ASA 9.1(3)
ASA CX 9.2(1)

You can now configure ASA CX service policies per
context on the ASA.

Note  Although you can configure per context ASA
service policies, the ASA CX module itself
(configured in PRSM) is a single context mode
device; the context-specific traffic coming from the
ASA is checked against the common ASA CX

policy.

We did not modify any screens.

Filtering packets captured on the ASA CX
backplane

ASA 9.1(3)
ASA CX 9.2(1)

You can now filter packets captured on the ASA CX
backplane using the match or access-list keyword with the
capture interface asa_dataplane command.

Control traffic specific to the ASA CX module is not
affected by the access-list or match filtering; the ASA
captures all control traffic.

In multiple context mode, configure the packet capture per
context. Note that all control traffic in multiple context
mode goes only to the system execution space. Because
control traffic cannot be filtered using an access-list or
match, these options are not available in the system
execution space.

We did not modify any ASDM screens.
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